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Microsoft Excel 2010 Step-by-Step Exercises 

PivotTables and PivotCharts: Exercise 3 

In this exercise you will: 

 Nest fields in the PivotTable 
 Experiment with the layout of PivotTable fields 
 Apply some PivotTable Options 
 Expand and collapse groups 

Introduction 

This exercise assumes that you have completed the steps in Exercise 2 and continues from the 
point where you saved the workbook after Step 34. If you didn’t save your work, or wish to omit 
the previous exercises, you can download a copy of the completed Exercise 2 workbook 
CommodityShipments (PivotTables PivotCharts).xlsx from my web site at 
http://www.fontstuff.com/training/excel/stepbystep.htm 

The Project So Far 

In Exercise 2 you added a field to the PivotTable, experimented with custom labels and added 
grouping to the CountryFrom field. The elements of the CountryFrom field make up the Row Labels 
and are divided into two groups, South America and North America. The elements of the CountryTo 
field make up the Column Labels. The main captions for the Row Labels and Column Labels have 
been changed to Exporter and Destination respectively. Where the fields intersect the Values 
represent Total Tonnes being the total tonnage of shipments made during the period of the data. 
The PivotTable worksheet currently looks like this (Fig. 1): 

 

Fig. 1 The PivotTable created in Exercise 2. 

http://www.fontstuff.com/training/excel/stepbystep.htm
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Adding a Third Field 

When a PivotTable contains only two fields the most obvious arrangement is to show the elements 
of one field across the worksheet (as Column Labels) and those of the other field down the 
worksheet (as Row Labels), forming a grid in which the intersecting elements can display a value. 
Where, then, would you display a third (or fourth or more) field? One way to do this is to “nest” the 
field inside one of the existing ones. Let’s see how this works… 

Step 35:  In the PivotTable Field List click the checkbox next to Year to place a tick in it. 

Excel places the field in the Values box and labels it Sum of Year. This is obviously the wrong place, 
but Excel saw that the column of data consisted entirely of numbers and therefore assumed that it 
was a numerical value to be calculated. Let’s move it to a more suitable place. 

Step 36:  In the PivotTable Field List, drag the button marked Sum of Year from the 
Values box to the Row Labels box and drop it underneath the CountryFrom button. 

Note: Instead of dragging you could have clicked the down-arrow on the Sum of Year button 
and choose Move to Row Labels from the menu. 

Excel changes the button’s caption to Years indicating that its values are no longer being 
calculated. Your PivotTable probably doesn’t look any different yet because at the end of the last 
exercise we left the groups collapsed (i.e. showing only the group headings). If that is the case… 

Step 37:  Click the plus buttons adjacent each group heading (South America and North 
America) to expand the groups and reveal their contents. 

Now you can see how the PivotTable has included the Year field, showing a Total Tonnes value for 
each Year for each CountryFrom (Fig. 2). The Year field is shown nested inside the CountryFrom 
field. 

 

Fig. 2 The Year field is nested inside the CountryFrom field. 

Alternatively you could have the PivotTable show a Total Tonnes value for each CountryFrom for 
each Year. Do this simply by changing the arrangement of the fields in the PivotTable field List. 

Step 38:  Click the down-arrow on the Year button in the Row Labels box and choose Move 
Up from the menu. 

Note: Instead of using the menu you could drag the Year button and drop it above the 
CountryFrom button. 

Now the CountryFrom field is nested inside the Year field (Fig. 3). 
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Fig. 3 The CountryFrom field is nested inside the Year field. 

When dealing with multiple fields in a PivotTable the placement of fields in the PivotTable Field List 
dictates the layout of the PivotTable. As long as you choose an arrangement that is logical (unlike 
that when Excel decided to put the Year field in the Values box) you can use whatever arrangement 
suits your purpose or presents your data in the most pleasing way. 

Try this: Experiment with different arrangements of fields. Move the Year field from the 
Row Labels box to the Column Labels box. The same data is displayed but in a different 
way, making the PivotTable very wide. Now move the CountryTo field from the Column 
Labels box to the Row Labels box. Again the appearance of the PivotTable changes. 
Return the fields to their former locations with Year above CountryFrom in the Row Labels 
box and CountryTo in the Column Labels box. 

When fields are nested in a PivotTable, Excel displays subtotals for all but the innermost of the 
nested fields. For example, when Year was nested inside CountryFrom, (Fig. 2) individual values 
were shown for each Year with a subtotal for each CountryFrom. When CountryFrom was nested 
inside Year individual values were shown for each CountryFrom with a subtotal for each Year. 

Try this: Place a tick in the checkbox next to Commodity in the PivotTable Field List. Excel 
adds this field to the Row Labels box so that it is nested inside CountryFrom. Take a look at 
the values. Individual values are shown for each Commodity and subtotals are shown for 
CountryFrom and Year. Remove the Commodity field by unchecking the box or by clicking 
the down-arrow on its button and choosing Remove Field from the menu. 

PivotTable Options: Show Empty Cells as Zeroes 

Excel offers a wide range of options for how the PivotTable’s data is displayed. Let’s change a 
couple of them.  

When plotting one field against another, it is possible that there is no data for a particular 
combination of field elements. For example, in this set of data there were no shipments from 
Mexico to Belgium in the year 2006. The default in such an event is to leave the cell empty. As a 
result the cell where these two columns intersect (cell B9) is blank. Excel allows you to enter any 
value of your choice into such cells. 

Step 39:  Go to the Options tab of the PivotTable Tools section of the Ribbon and click the 
Options button (at the left end of the Ribbon). On the Layout & Format tab of the 
PivotTable Options dialog box make sure there is a tick in the checkbox next to For 
empty cells show: and type a zero (0) in the textbox next to it. Click the OK button to 
confirm your instruction and close the dialog box. 

Now all the cells in the Values section of the PivotTable that contain no data show a zero (Fig. 4). 

Note: This may or may not be a desirable thing to do depending upon the nature of your 
data. There is a difference between there being a value of zero (we know we didn’t make 
any shipments that year) and there being an absence of data (we don’t know whether or 
not we made any shipments because we don’t have that year’s data). However, on a 
PivotTable it makes no difference to the calculations because the results it displays are 
based on the source data (and any filters that may have been applied) and not necessarily 
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on what you can see on the PivotTable. Take a look at the data (Fig. 4) for South America, 
2006, Belgium. The values displayed are 7,587 (Argentina), 7,453 (Brazil) and 0 (Mexico). 
If these three values were calculated on a regular worksheet the Sum of the three cells 
(15,040) would be the same regardless of whether or not the Mexico value was a zero or 
an empty cell, because when calculating a Sum Excel treats an empty cell as zero. But if 
Excel were calculating an Average there would be a difference. The average of the three 
cells 7,587, 7,453 and 0 would be 5,013 but if instead of the cell containing a zero it were 
blank the Average would be 7,520, because when calculating an Average Excel ignores 
empty cells. However, if you were to change the Value Field Settings for the Tonnes field 

from Sum to Average you would see that the result displayed on the PivotTable would be 
the same whether the cells contained zeroes or were left empty. This shows that the 
PivotTable is calculating the source data and not necessarily what you see on screen. 

 

Fig. 4 The empty cells now contain zeroes. 

PivotTable Options: Show Group Subtotals 

Now that the PivotTable has groups, notice that in addition to the grand totals at the foot of the 
table, Excel has added subtotals to the innermost (Years) group values. The outer group values 
(South America and North America) do not initially show subtotals. When groups are collapsed 
Excel automatically shows subtotals for each grouping level but if you want all these subtotals to be 
displayed when the groups are expanded you need to ask for them. Here’s how… 

Step 40:  Go to the Design tab of the PivotTable Tools section of the Ribbon, click the 
button marked Subtotals in the Layout group, then choose Show all Subtotals at Top 
of Group (Fig. 5). 

 

Fig. 5 Ask Excel to display Subtotals. 

Now in addition to the Year subtotals the PivotTable displays subtotals for the major group (South 
America and North America) (Fig. 6). 
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Fig. 6 The PivotTable displays subtotals for all the grouping levels. 

Expanding and Collapsing Groups 

As you have already seen, you can collapse or expand a group by clicking the plus or minus 
buttons adjacent to the group member’s name. Doing this allows you to hide or show the contents 
of individual group members but if you want to do this for the whole group there’s an easier way. 
In fact, as usual with Excel, there’s more than one way. Take your choice… 

Step 41:  Right-click on one of the Year numbers in the leftmost column of the PivotTable 
then point to Expand/Collapse and choose Collapse Entire Field from the submenu 
(Fig. 7). 

 

Fig. 7 Collapse the entire field. 

In one step Excel collapses all the members of the Year field to display only their subtotals (Fig. 8). 

 

Fig. 8 The Year field has been collapsed. 

If you had instead right-clicked on, for example, South America and given the same instruction 
then that field would have collapsed and only the subtotals for South America and North America 
would show. 

Step 42:  Right-click on one of the Year numbers in the leftmost column of the PivotTable 
then point to Expand/Collapse and choose Expand Entire Field from the submenu. 



Microsoft Excel 2010  Step-by-Step Pivot Tables 

©Martin Green www.fontstuff.com 6 

This returns the PivotTable to its previous state with all the data on show. Now let’s try doing it a 
different way… 

Step 43:  With one of the Year numbers selected, go to the Options tab of the PivotTable 
Tools section of the Ribbon, and click the Collapse Entire Field button in the Active 
Field group (Fig. 9). 

 

Fig. 9 Click the Collapse Entire Field button. 

All the members of the Year group have been collapsed. Notice that the selection has not changed. 

Step 44:  Click the Collapse Entire Field button in the Active Field group again. 

Although the selected cell contained a member of the Year group, since that group was already 
collapsed, Excel collapsed the next group above it to return the PivotTable to the condition it was in 
at the start of this exercise (Fig. 1). 

Note: Both the right-click menu and the ribbon offer Expand Entire Field commands to 
reverse the process. 

You might be wondering what would happen if you tried to expand or collapse a field that wasn’t 
grouped. 

Try this: Select one of the Value field cells in the centre of the PivotTable. You will see 
that the Collapse and Expand buttons on the Ribbon are disabled because Excel does not 
know which field you might want to expand or collapse. Right-click the cell. See that the 
Expand/Collapse option does not appear on the right-click menu. 

Step 45:  Select one of the country names (such as Germany) and either by right-clicking or 
using the Ribbon button ask Excel to Expand Entire Field. Excel doesn’t know exactly 
what you want to do but it offers you a list of fields to choose from (Fig. 10). You can 
probably guess what would happen if you chose an existing field so choose Month, a field 
we haven’t included yet, and click OK. 

 

Fig. 10 Excel asks which field you want to expand. 

Because the Month field wasn’t already shown on the PivotTable Excel added it and expanded it 
(Fig. 11) and, since we had previously asked for subtotals to be shown it also added subtotals for 
the Month field. 
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Fig. 11 Excel added the Month field and inserted subtotals for it. 

Conclusion 

This concludes Exercise 3. In this exercise you have learned how to rearrange fields on the 
PivotTable, to apply PivotTable options to show group subtotals and to display zeroes in empty 
cells, and discovered different ways to expand and collapse groups to show or hide information on 
the PivotTable. The next exercise will continue from this point so if you wish to proceed to the next 
exercise you should save the file in its current state. 
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